## Contents

### About this manual

- About this manual ................................................................. 1

### Safety information

- Safety information .................................................................. 2

### Chapter 1  Basics and Assembly

- Safety Information for Users .................................................. 1-2
- System conception .................................................................. 1-3
- Dimensions ............................................................................. 1-5
- Installation ............................................................................... 1-7
- Demounting and module exchange ....................................... 1-11
- Wiring .................................................................................... 1-12
- Installation guidelines ......................................................... 1-14
- General data .......................................................................... 1-17

### Chapter 2  Hardware description

- Properties.................................................................................. 2-2
- Structure.................................................................................... 2-3
- Technical Data .......................................................................... 2-7

### Chapter 3  Deployment CPU 21x-2BP03

- Assembly.................................................................................. 3-1
- Start-up behavior ..................................................................... 3-2
- Addressing ............................................................................... 3-3
- Hints for the deployment of the MPI interface ....................... 3-5
- Hardware configuration - CPU ............................................... 3-6
- Hardware configuration - I/O modules .................................. 3-8
- Setting CPU parameters ....................................................... 3-9
- Project transfer ...................................................................... 3-13
- Operating modes .................................................................... 3-17
- Overall reset .......................................................................... 3-19
- Firmware update ..................................................................... 3-21
- Factory reset .......................................................................... 3-23
- VIPA specific diagnostic entries .......................................... 3-24
- Using test functions for control and monitoring of variables .. 3-26

### Chapter 4  PROFIBUS communication

- Overview ................................................................................. 4-1
- Deployment as PROFIBUS DP slave ...................................... 4-3
- DP slave parameters ............................................................. 4-6
- Diagnostic functions .............................................................. 4-8
- Internal status messages to CPU .......................................... 4-11
- PROFIBUS installation guidelines ........................................ 4-13
- Example .................................................................................. 4-16
About this manual

This manual describes the System 200V CPU 21x-2BP03 from VIPA. Here you may find every information for commissioning and operation.

Overview

Chapter 1: Basics and Assembly
The focus of this chapter is on the introduction of the VIPA System 200V. Here you will find the information required to assemble and wire a controller system consisting of System 200V components. Besides the dimensions the general technical data of System 200V will be found.

Chapter 2: Hardware description
Here the hardware components of the CPU are described. The technical data are at the end of the chapter.

Chapter 3: Deployment CPU 21x-2BP03
This chapter describes the deployment of the CPU in the System 200V. The description refers directly to the CPU and to the deployment in connection with peripheral modules, mounted on a profile rail together with the CPU at the backplane bus.

Chapter 4: PROFIBUS communication
This chapter describes applications of the CPU 21x-2BP03 with PROFIBUS. You'll get all information for the deployment of an intelligent PROFIBUS DP slave.
About this manual

Objective and contents
This manual describes the System 200V CPU 21x-2BP03 from VIPA. It contains a description of the construction, project implementation and usage.
This manual is part of the documentation package with order number HB97E_CPU and relevant for:

<table>
<thead>
<tr>
<th>Product</th>
<th>Order number</th>
<th>as of state:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 21xDP</td>
<td>VIPA CPU 21x-2BP03</td>
<td>CPU-HW 01, CPU-FW V 4.1.7</td>
</tr>
</tbody>
</table>

Target audience
The manual is targeted at users who have a background in automation technology.

Structure of the manual
The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.

Guide to the document
The following guides are available in the manual:
- an overall table of contents at the beginning of the manual
- an overview of the topics for every chapter

Availability
The manual is available in:
- printed form, on paper
- in electronic form as PDF-file (Adobe Acrobat Reader)

Icons
Important passages in the text are highlighted by following icons and headings:

Danger!
Immediate or likely danger.
Personal injury is possible.

Attention!
Damages to property is likely if these warnings are not heeded.

Note!
Supplementary information and useful tips.
Safety information

Applications conforming with specifications

The CPU 21x is constructed and produced for:
• all VIPA System 200V components
• communication and process control
• general control and automation applications
• industrial applications
• operation within the environmental conditions specified in the technical data
• installation into a cubicle

Danger!
This device is not certified for applications in
• in explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the
• project design department
• installation department
• commissioning
• operation

The following conditions must be met before using or commissioning the components described in this manual:

• Hardware modifications to the process control system should only be carried out when the system has been disconnected from power!

• Installation and hardware modification only by properly trained personnel.

• The national rules and regulations of the respective country must be satisfied (installation, safety, EMC ...)

Disposal

National rules and regulations apply to the disposal of the unit!
Chapter 1 Basics and Assembly

Overview

The focus of this chapter is on the introduction of the VIPA System 200V. Here you will find the information required to assemble and wire a controller system consisting of System 200V components. Besides the dimensions the general technical data of System 200V will be found.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1 Basics and Assembly</td>
<td>1-1</td>
</tr>
<tr>
<td>Safety Information for Users</td>
<td>1-2</td>
</tr>
<tr>
<td>System conception</td>
<td>1-3</td>
</tr>
<tr>
<td>Dimensions</td>
<td>1-5</td>
</tr>
<tr>
<td>Installation</td>
<td>1-7</td>
</tr>
<tr>
<td>Demounting and module exchange</td>
<td>1-11</td>
</tr>
<tr>
<td>Wiring</td>
<td>1-12</td>
</tr>
<tr>
<td>Installation guidelines</td>
<td>1-14</td>
</tr>
<tr>
<td>General data</td>
<td>1-17</td>
</tr>
</tbody>
</table>
Safety Information for Users

Handling of electrostatic sensitive modules
VIPA modules make use of highly integrated components in MOS-Technology. These components are extremely sensitive to over-voltages that can occur during electrostatic discharges.
The following symbol is attached to modules that can be destroyed by electrostatic discharges.

The Symbol is located on the module, the module rack or on packing material and it indicates the presence of electrostatic sensitive equipment.
It is possible that electrostatic sensitive equipment is destroyed by energies and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves before handling electrostatic sensitive modules and they can damage components thereby, causing the module to become inoperable or unusable.
Modules that have been damaged by electrostatic discharges can fail after a temperature change, mechanical shock or changes in the electrical load.
Only the consequent implementation of protection devices and meticulous attention to the applicable rules and regulations for handling the respective equipment can prevent failures of electrostatic sensitive modules.

Shipping of electrostatic sensitive modules
Modules must be shipped in the original packing material.

Measurements and alterations on electrostatic sensitive modules
When you are conducting measurements on electrostatic sensitive modules you should take the following precautions:
• Floating instruments must be discharged before use.
• Instruments must be grounded.
Modifying electrostatic sensitive modules you should only use soldering irons with grounded tips.

Attention!
Personnel and instruments should be grounded when working on electrostatic sensitive modules.
System conception

Overview

The System 200V is a modular automation system for assembly on a 35mm profile rail. By means of the peripheral modules with 4, 8 and 16 channels this system may properly be adapted matching to your automation tasks.

Components

The System 200V consists of the following components:

- **Head modules** like CPU and bus coupler
- **Periphery modules** like I/O, function und communication modules
- **Power supplies**
- **Extension modules**

Head modules

With a head module CPU respectively bus interface and DC 24V power supply are integrated to one casing.

Via the integrated power supply the CPU respectively bus interface is power supplied as well as the electronic of the connected periphery modules.

Periphery modules

The modules are direct installed on a 35mm profile rail and connected to the head module by a bus connector, which was mounted on the profile rail before.

Most of the periphery modules are equipped with a 10pin respectively 18pin connector. This connector provides the electrical interface for the signaling and supplies lines of the modules.
Power supplies

With the System 200V the DC 24V power supply can take place either externally or via a particularly for this developed power supply. The power supply may be mounted on the profile rail together with the System 200V modules. It has no connector to the backplane bus.

Expansion modules

The expansion modules are complementary modules providing 2- or 3wire connection facilities. The modules are not connected to the backplane bus.

Structure/dimensions

- Profile rail 35mm
- Dimensions of the basic enclosure:
  1 tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3
  2 tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3

Installation

Please note that you can only install header modules, like the CPU, the PC and couplers at slot 1 or 1 and 2 (for double width modules).

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>Head module (double width)</td>
</tr>
<tr>
<td>[2]</td>
<td>Head module (single width)</td>
</tr>
<tr>
<td>[3]</td>
<td>Periphery module</td>
</tr>
</tbody>
</table>

Note

A maximum of 32 modules can be connected at the backplane bus. Take attention that here the maximum sum current of 3.5A is not exceeded. Please install modules with a high current consumption directly beside the header module.
Dimensions

1-tier width (HxWxD) in mm: 76 x 25.4 x 74
2-tier width (HxWxD) in mm: 76 x 50.8 x 74
Function modules/
Extension modules

CPUs (here with
EasyConn from
VIPA)
Installation

General
The modules are each installed on a 35mm profile rail and connected via a bus connector. Before installing the module the bus connector is to be placed on the profile rail before.

Profile rail
For installation the following 35mm profile rails may be used:

<table>
<thead>
<tr>
<th>Order number</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>290-1AF00</td>
<td>35mm profile rail</td>
<td>Length 2000mm, height 15mm</td>
</tr>
<tr>
<td>290-1AF30</td>
<td>35mm profile rail</td>
<td>Length 530mm, height 15mm</td>
</tr>
</tbody>
</table>

Bus connector
System 200V modules communicate via a backplane bus connector. The backplane bus connector is isolated and available from VIPA in of 1-, 2-, 4- or 8tier width.
The following figure shows a 1tier connector and a 4tier connector bus:

The bus connector is to be placed on the profile rail until it clips in its place and the bus connections look out from the profile rail.

<table>
<thead>
<tr>
<th>Order number</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>290-0AA10</td>
<td>Bus connector</td>
<td>1tier</td>
</tr>
<tr>
<td>290-0AA20</td>
<td>Bus connector</td>
<td>2tier</td>
</tr>
<tr>
<td>290-0AA40</td>
<td>Bus connector</td>
<td>4tier</td>
</tr>
<tr>
<td>290-0AA80</td>
<td>Bus connector</td>
<td>8tier</td>
</tr>
</tbody>
</table>
Installation on a profile rail

The following figure shows the installation of a 4-tier width bus connector in a profile rail and the slots for the modules. The different slots are defined by guide rails.

1. Header module (double width)
2. Header module (single width)
3. Peripheral module
4. Guide rails

Assembly regarding the current consumption

- Use bus connectors as long as possible.
- Sort the modules with a high current consumption right beside the header module. In the service area of www.vipa.com a list of current consumption of every System 200V module can be found.
Assembly possibilities

Please regard the allowed environmental temperatures:

- horizontal assembly: from 0 to 60°C
- vertical assembly: from 0 to 40°C
- lying assembly: from 0 to 40°C

The horizontal assembly always starts at the left side with a header module, then you install the peripheral modules beside to the right.

You may install up to 32 peripheral modules.

Please follow these rules during the assembly!

- Turn off the power supply before you install or remove any modules!
- Make sure that a clearance of at least 60mm exists above and 80mm below the middle of the profile rail.
- Every row must be completed from left to right and it has to start with a header module.
- Modules are to be installed side by side. Gaps are not permitted between the modules since this would interrupt the backplane bus.
- A module is only installed properly and connected electrically when it has clicked into place with an audible click.
- Slots after the last module may remain unoccupied.

Note!
A maximum of 32 modules can be connected at the back plane bus. Take attention that here the maximum sum current of 3.5A is not exceeded.
Assembly procedure

- Install the profile rail. Make sure that a clearance of at least 60mm exists above and 80mm below the middle of the profile rail.

- Press the bus connector into the profile rail until it clips securely into place and the bus-connectors look out from the profile rail. This provides the basis for the installation of your modules.

- Start at the outer left location with the installation of your header module and install the peripheral modules to the right of this.

- Insert the module that you are installing into the profile rail at an angle of 45 degrees from the top and rotate the module into place until it clicks into the profile rail with an audible click. The proper connection to the backplane bus can only be guaranteed when the module has properly clicked into place.

Attention!
Power must be turned off before modules are installed or removed!
Demounting and module exchange

1. Remove if exists the wiring to the module, by pressing both locking lever on the connector and pulling the connector.

2. The casing of the module has a spring loaded clip at the bottom by which the module can be removed.

3. The clip is unlocked by pressing the screwdriver in an upward direction.

4. Withdraw the module with a slight rotation to the top.

Attention!
Power must be turned off before modules are installed or removed!
Please regard that the backplane bus is interrupted at the point where the module was removed!
Wiring

Overview

Most peripheral modules are equipped with a 10pole or a 18pole connector. This connector provides the electrical interface for the signaling and supply lines of the modules.

The modules carry spring-clip connectors for interconnections and wiring. The spring-clip connector technology simplifies the wiring requirements for signaling and power cables.

In contrast to screw terminal connections, spring-clip wiring is vibration proof. The assignment of the terminals is contained in the description of the respective modules.

You may connect conductors with a diameter from 0.08mm$^2$ up to 2.5mm$^2$ (max. 1.5mm$^2$ for 18pole connectors).

The following figure shows a module with a 10pole connector.

Note!
The spring-clip is destroyed if you push the screwdriver into the wire port! Make sure that you only insert the screwdriver into the square hole of the connector!
Wiring procedure

- Install the connector on the module until it locks with an audible click. For this purpose you press the two clips together as shown. The connector is now in a permanent position and can easily be wired.

The following section shows the wiring procedure from top view.

- Insert a screwdriver at an angle into the square opening as shown.
- Press and hold the screwdriver in the opposite direction to open the contact spring.

- Insert the stripped end of the wire into the round opening. You can use wires with a diameter of 0.08mm² to 2.5mm² (1.5mm² for 18pole connectors).

- By removing the screwdriver the wire is connected safely with the plug connector via a spring.

**Note!**

Wire the power supply connections first followed by the signal cables (inputs and outputs).
Installation guidelines

General
The installation guidelines contain information about the interference free deployment of System 200V systems. There is the description of the ways, interference may occur in your control, how you can make sure the electromagnetic digestibility (EMC), and how you manage the isolation.

What means EMC?
Electromagnetic digestibility (EMC) means the ability of an electrical device, to function error free in an electromagnetic environment without being interferenced res. without interfering the environment.
All System 200V components are developed for the deployment in hard industrial environments and fulfill high demands on the EMC. Nevertheless you should project an EMC planning before installing the components and take conceivable interference causes into account.

Possible interference causes
Electromagnetic interferences may interfere your control via different ways:
- Electromagnetic fields (RF coupling)
- Magnetic fields with power frequency
- I/O signal conductors
- Bus system
- Current supply
- Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the distance to the interference cause, interferences to your control occur by means of different coupling mechanisms.
One differs:
- galvanic coupling
- capacitive coupling
- inductive coupling
- radiant coupling
Basic rules for EMC

In the most times it is enough to take care of some elementary rules to guarantee the EMC. Please regard the following basic rules when installing your PLC.

- Take care of a correct area-wide grounding of the inactive metal parts when installing your components.
  - Install a central connection between the ground and the protected earth conductor system.
  - Connect all inactive metal extensive and impedance-low.
  - Please try not to use aluminum parts. Aluminum is easily oxidizing and is therefore less suitable for grounding.

- When cabling, take care of the correct line routing.
  - Organize your cabling in line groups (high voltage, current supply, signal and data lines).
  - Always lay your high voltage lines and signal res. data lines in separate channels or bundles.
  - Route the signal and data lines as near as possible beside ground areas (e.g. suspension bars, metal rails, tin cabinet).

- Proof the correct fixing of the lead isolation.
  - Data lines must be laid isolated (for details see below).
  - Analog lines must be laid isolated. When transmitting signals with small amplitudes the one sided laying of the isolation may be favorable.
  - Lay the line isolation extensively on an isolation/protected earth conductor rail directly after the cabinet entry and fix the isolation with cable clamps.
  - Make sure that the isolation/protected earth conductor rail is connected impedance-low with the cabinet.
  - Use metallic or metalized plug cases for isolated data lines.

- In special use cases you should appoint special EMC actions.
  - Wire all inductivities with erase links, which are not addressed by the System SLIO modules.
  - For lightening cabinets you should avoid luminescent lamps.

- Create a homogeneous reference potential and ground all electrical operating supplies when possible.
  - Please take care for the targeted employment of the grounding actions. The grounding of the PLC is a protection and functionality activity.
  - Connect installation parts and cabinets with the System SLIO in star topology with the isolation/protected earth conductor system. So you avoid ground loops.
  - If potential differences between installation parts and cabinets occur, lay sufficiently dimensioned potential compensation lines.
Electrical, magnetically and electromagnetic interference fields are weakened by means of an isolation, one talks of absorption.

Via the isolation rail, that is connected conductive with the rack, interference currents are shunt via cable isolation to the ground. Hereby you have to make sure, that the connection to the protected earth conductor is impedance-low, because otherwise the interference currents may appear as interference cause.

When isolating cables you have to regard the following:

- If possible, use only cables with isolation tangle.
- The hiding power of the isolation should be higher than 80%.
- Normally you should always lay the isolation of cables on both sides. Only by means of the both-sided connection of the isolation you achieve high quality interference suppression in the higher frequency area.
  Only as exception you may also lay the isolation one-sided. Then you only achieve the absorption of the lower frequencies. A one-sided isolation connection may be convenient, if:
    - the conduction of a potential compensating line is not possible
    - analog signals (some mV res. µA) are transferred
    - foil isolations (static isolations) are used.
- With data lines always use metallic or metalized plugs for serial couplings. Fix the isolation of the data line at the plug rack. Do not lay the isolation on the PIN 1 of the plug bar!
- At stationary operation it is convenient to strip the insulated cable interruption free and lay it on the isolation/protected earth conductor line.
- To fix the isolation tangles use cable clamps out of metal. The clamps must clasp the isolation extensively and have well contact.
- Lay the isolation on an isolation rail directly after the entry of the cable in the cabinet. Lead the isolation further on to the System 200V module and don't lay it on there again!

**Please regard at installation!**

At potential differences between the grounding points, there may be a compensation current via the isolation connected at both sides.

Remedy: Potential compensation line.
General data

Structure/ dimensions

- Profile rail 35mm
- Peripheral modules with recessed labelling
- Dimensions of the basic enclosure:
  1-tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3
  2-tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3

Reliability

- Wiring by means of spring pressure connections (CageClamps) at the front-facing connector, core cross-section 0.08 ... 2.5mm$^2$ or 1.5mm$^2$ (18pole plug)
- Complete isolation of the wiring when modules are exchanged
- Every module is isolated from the backplane bus
General data

<table>
<thead>
<tr>
<th>Conformity and approval</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conformity</strong></td>
<td></td>
</tr>
<tr>
<td>CE</td>
<td>2006/95/EC</td>
</tr>
<tr>
<td></td>
<td>2004/108/EC</td>
</tr>
<tr>
<td><strong>Approval</strong></td>
<td></td>
</tr>
<tr>
<td>UL</td>
<td>UL 508</td>
</tr>
<tr>
<td>others</td>
<td></td>
</tr>
<tr>
<td><strong>RoHS</strong></td>
<td>2011/65/EU</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Protection of persons and device protection</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of protection</strong></td>
<td>-</td>
</tr>
<tr>
<td><strong>Electrical isolation</strong></td>
<td></td>
</tr>
<tr>
<td>to the field bus</td>
<td>-</td>
</tr>
<tr>
<td>to the process level</td>
<td>-</td>
</tr>
<tr>
<td><strong>Insulation resistance</strong></td>
<td>EN 61131-2</td>
</tr>
<tr>
<td><strong>Insulation voltage to reference earth</strong></td>
<td></td>
</tr>
<tr>
<td>Inputs / outputs</td>
<td>-</td>
</tr>
<tr>
<td><strong>Protective measures</strong></td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Environmental conditions to EN 61131-2</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Climatic</strong></td>
<td></td>
</tr>
<tr>
<td>Storage / transport</td>
<td>EN 60068-2-14</td>
</tr>
<tr>
<td><strong>Operation</strong></td>
<td></td>
</tr>
<tr>
<td>Horizontal installation</td>
<td>EN 61131-2</td>
</tr>
<tr>
<td>Vertical installation</td>
<td>EN 61131-2</td>
</tr>
<tr>
<td>Air humidity</td>
<td>EN 60068-2-30</td>
</tr>
<tr>
<td>Pollution</td>
<td>EN 61131-2</td>
</tr>
<tr>
<td><strong>Mechanical</strong></td>
<td></td>
</tr>
<tr>
<td>Oscillation</td>
<td>EN 60068-2-6</td>
</tr>
<tr>
<td>Shock</td>
<td>EN 60068-2-27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mounting conditions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting place</td>
<td>-</td>
</tr>
<tr>
<td>Mounting position</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EMC</th>
<th>Standard</th>
<th>Comment</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Emitted interference</td>
<td>EN 61000-6-4</td>
<td>Class A (Industrial area)</td>
<td></td>
</tr>
<tr>
<td>Noise immunity zone B</td>
<td>EN 61000-6-2</td>
<td>Industrial area</td>
<td></td>
</tr>
<tr>
<td>EN 61000-4-2</td>
<td>ESD</td>
<td>8kV at air discharge (degree of severity 3), 4kV at contact discharge (degree of severity 2)</td>
<td></td>
</tr>
<tr>
<td>EN 61000-4-3</td>
<td>HF field immunity (casing)</td>
<td>80MHz … 1000MHz, 10V/m, 80% AM (1kHz), 1.4GHz ... 2.0GHz, 3V/m, 80% AM (1kHz), 2GHz ... 2.7GHz, 1V/m, 80% AM (1kHz)</td>
<td></td>
</tr>
<tr>
<td>EN 61000-4-6</td>
<td>HF conducted</td>
<td>150kHz … 80MHz, 10V, 80% AM (1kHz)</td>
<td></td>
</tr>
<tr>
<td>EN 61000-4-4</td>
<td>Burst, degree of severity 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EN 61000-4-5</td>
<td>Surge, installation class 3 * )</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Due to the high-energetic single pulses with Surge an appropriate external protective circuit with lightning protection elements like conductors for lightning and overvoltage is necessary.
Chapter 2  Hardware description

Overview
Here the hardware components of the CPU are described. The technical data are at the end of the chapter.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2</td>
<td>2-1</td>
</tr>
<tr>
<td>Hardware description</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>2-2</td>
</tr>
<tr>
<td>Structure</td>
<td>2-3</td>
</tr>
<tr>
<td>Technical data</td>
<td>2-7</td>
</tr>
</tbody>
</table>
Properties

CPU 21x-2BP03

- Instruction set compatible with Siemens STEP® 7
- Configuration by means of the Siemens SIMATIC manager
- Integrated V-Bus controller for controlling System 200V peripherals
- Integrated 24V power supply
- Total address range: 1024Byte inputs, 1024Byte outputs
  (128Byte process image each)
- 96 / 128kByte of work memory "on board"
- 144 / 192kByte of load memory "on board"
- MMC slot (for user program)
- Battery backed clock
- MP²I interface for data transfer
- Status LEDs for operating mode and diagnostics
- Integrated PROFIBUS slave

![CPU 214DP and CPU 215DP](image)

### Order data

<table>
<thead>
<tr>
<th>Type</th>
<th>Order number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU 214DP</td>
<td>VIPA 214-2BP03</td>
<td>SPS CPU 214 with PROFIBUS slave and 96/144kByte of work/load memory</td>
</tr>
<tr>
<td>CPU 215DP</td>
<td>VIPA 215-2BP03</td>
<td>SPS CPU 214 with PROFIBUS slave and 128/192kByte of work/load memory</td>
</tr>
</tbody>
</table>
Structure

Front view CPU 21xDP

1. Operating mode switch
2. LEDs of the CPU
3. Slot for MMC memory card
4. MP2I interface
5. Slot for 24V DC power supply
6. LEDs of the PROFIBUS DP slave
7. PROFIBUS DP interface

Interfases

DP slave
- shield
- n. c.
- Rx/Tx-D-P (line B)
- RTS
- M5V
- 5V
- n. c.
- Rx/Tx-D-N (line A)
- n. c.

MP2I
- reserved
- M24V
- Rx/Tx-D-P (line B)
- RTS
- M5V
- 5V
- P24V
- Rx/Tx-D-N (line A)
- n. c.

X1
- + DC 24 V
- 0 V
Power supply
The CPU has an internal power supply. This is connected to an external supply voltage via two terminals located on the front of the unit. The power supply requires DC 24V (20.4 ... 28.8V). In addition to the electronic circuitry of the CPU this supply voltage is used for the modules connected to the backplane bus. The electronic circuitry of the CPU is not dc-insulated from the supply voltage. The power supply is protected against reverse polarity and short circuits.

Note!
Please ensure that the polarity of the supply voltage is correct.

MP²I interface
The MPI unit provides the link for the data transfer between the CPU and the PC. Via bus communication you are able to exchange programs and data between different CPUs that are linked over MPI.
For a serial exchange between the partners you normally need a special MPI-converter. But now you are also able to use the VIPA "Green Cable" (Order-No. VIPA 950-0KB00), which allows you to establish a serial peer-to-peer connection over the MPI interface.
Please regard the "Hints for the deployment of the MPI interface" in chapter "Deployment CPU 21x".

PROFIBUS interface
The CPU is connected to the PROFIBUS system by means of a 9pin jack.

Note!
More information about PROFIBUS can be found in the chapter "PROFIBUS communication".
The CPUs have an integrated work and a load memory. The memories are battery-buffered.

<table>
<thead>
<tr>
<th>Order number</th>
<th>Work memory</th>
<th>Load memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIPA 214-2BP03</td>
<td>96kByte</td>
<td>144kByte</td>
</tr>
<tr>
<td>VIPA 215-2BP03</td>
<td>128kByte</td>
<td>192kByte</td>
</tr>
</tbody>
</table>

In the load memory there are program code and blocks stored together with the header information. The program parts and blocks, which are relevant for the running program, are loaded to the work memory during the program sequence.

With the operating mode switch you may switch the CPU between STOP and RUN. During the transition from STOP to RUN the operating mode START-UP is driven by the CPU. By Switching to MR (Memory Reset) you request an overall reset with following load from MMC, if a project there exists.

You may install a VIPA MMC memory card in this slot as external storage device (Order No.: VIPA 953-0KX10). The access to the MMC takes always place after an overall reset.

A rechargeable battery is installed on every CPU 21x to safeguard the contents of the RAM when power is removed. This battery is also used to buffer the internal clock. The rechargeable battery is maintained by a charging circuit that receives its power from the internal power supply and that maintain the clock and RAM for a max. period of 30 days.

Due to a long storage of the CPU, the battery may be discharged excessively. Please connect the CPU at least for 24 hours to the power supply, to achieve the full buffer capacity. After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset, because with an empty battery the RAM content is undefined.
**LEDs CPU**

The CPU has got LEDs on its front side. In the following the usage and the according colors of the LEDs is described.

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PW</td>
<td>green</td>
<td>Indicates CPU power on.</td>
</tr>
<tr>
<td>R</td>
<td>green</td>
<td>CPU status is RUN.</td>
</tr>
<tr>
<td>S</td>
<td>yellow</td>
<td>CPU status is STOP.</td>
</tr>
<tr>
<td>SF</td>
<td>red</td>
<td>Is turned on if a system error is detected (hardware defect)</td>
</tr>
<tr>
<td>FC</td>
<td>yellow</td>
<td>Is turned on when variables are forced (fixed).</td>
</tr>
<tr>
<td>MC</td>
<td>yellow</td>
<td>This LED blinks when the MMC is accessed.</td>
</tr>
</tbody>
</table>

**LEDs PROFIBUS DP slave**

The LEDs are located in the left half of the front panel and they are used for diagnostic purposes. The following table shows the color and the significance of these LEDs.

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ER</td>
<td>red</td>
<td>Error</td>
</tr>
</tbody>
</table>

On: Error in PROFIBUS part detected respectively CPU has been stopped.  
Flashing (2Hz): Initialization error  
Flashing (10Hz): Supply voltage < DC18V  
Flashing *alternately* with RD: Configuration error (error at Master configuration)  
Flashing *simultaneously* with RD: Error in parameterization  

| RD   | green | Ready |

On: Data transfer via back plane bus  
Flashing: Self-test result is positive (READY) and successful initialization  

| DE   | green | DE (Data exchange)  
On: Indicates an active PROFIBUS communication. |
## Technical data

### Order no.

214-2BP03

<table>
<thead>
<tr>
<th>Technical data power supply</th>
<th>214-2BP03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 214DP</td>
</tr>
<tr>
<td>Power supply (rated value)</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Power supply (permitted range)</td>
<td>DC 20.4 ... 28.8 V</td>
</tr>
<tr>
<td>Reverse polarity protection</td>
<td></td>
</tr>
<tr>
<td>Current consumption (no-load operation)</td>
<td>100 mA</td>
</tr>
<tr>
<td>Inrush current</td>
<td>65 A</td>
</tr>
<tr>
<td>( I^2 t )</td>
<td>0.75 A^2s</td>
</tr>
<tr>
<td>Max. current drain at backplane bus</td>
<td>3 A</td>
</tr>
<tr>
<td>Power loss</td>
<td>5 W</td>
</tr>
</tbody>
</table>

### Load and working memory

| Load memory, integrated                     | 144 KB        |
| Load memory, maximum                        | 144 KB        |
| Work memory, integrated                      | 96 KB         |
| Work memory, maximal                         | 96 KB         |
| Memory divided in 50% program / 50% data     |               |
| Memory card slot                            | MMC-Card with max. 512 MB |

### Hardware configuration

| Racks, max.                                  | 4             |
| Modules per rack, max.                       | total max. 32 |
| Number of integrated DP master               |               |
| Number of DP master via CP                   | 8             |
| Operable function modules                    | 32            |
| Operable communication modules PtP           | 32            |
| Operable communication modules LAN           |               |

### Command processing times

| Bit instructions, min.                      | 0.18 \( \mu s \) |
| Word instruction, min.                      | 0.78 \( \mu s \)  |
| Double integer arithmetic, min.             | 1.8 \( \mu s \)   |
| Floating-point arithmetic, min.             | 40 \( \mu s \)    |

### Timers/Counters and their retentive characteristics

| Number of S7 counters                        | 256           |
| S7 counter remanence                        | adjustable 0 up to 64 |
| S7 counter remanence adjustable             | C0 .. C7      |
| Number of S7 times                           | 256           |
| S7 times remanence                          | adjustable 0 up to 128 |
| S7 times remanence not retentive            |               |

### Data range and retentive characteristic

| Number of flags                              | 8192 Bit      |
| Bit memories retentive characteristic         | adjustable 0 up to 256 |
| Bit memories retentive characteristic preset  | MB0 .. MB15   |
| Number of data blocks                         | 2047          |
| Max. data blocks size                         | 16 KB         |
| Number range DBs                             | 1 ... 2047    |
| Max. local data size per execution level      | 1024 Byte     |
| Max. local data size per block                | 1024 Byte     |

### Blocks

| Number of OBs                                | 14            |
| Maximum OB size                              | 16 KB         |
| Total number DBs, FBs, FCs                   |               |
| Number of FBs                                | 1024          |
| Maximum FB size                              | 16 KB         |
| Number range FBs                             | 0 ... 1023    |
### Chapter 2   Hardware description

**Order no.** 214-2BP03

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of FCs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FC size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FCs</td>
<td>0 ... 1023</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>1</td>
</tr>
</tbody>
</table>

**Time**

- Real-time clock buffered: ✓
- Clock buffered period (min.): 30 d
- Type of buffering: Vanadium Rechargeable Lithium Batterie
- Load time for 50% buffering period: 20 h
- Load time for 100% buffering period: 48 h
- Accuracy (max. deviation per day): 10 s
- Number of operating hours counter: 8
- Clock synchronization: -
- Synchronization via MPI: -
- Synchronization via Ethernet (NTP): -

**Address areas (I/O)**

- Input I/O address area: 1024 Byte
- Output I/O address area: 1024 Byte
- Process image adjustable: -
- Input process image preset: 128 Byte
- Output process image preset: 128 Byte
- Input process image maximal: 128 Byte
- Output process image maximal: 128 Byte
- Digital inputs: 8192
- Digital outputs: 8192
- Digital inputs central: 512
- Digital outputs central: 512
- Integrated digital inputs: -
- Integrated digital outputs: -
- Analog inputs: 512
- Analog outputs: 512
- Analog inputs, central: 128
- Analog outputs, central: 128
- Integrated analog inputs: -
- Integrated analog outputs: -

**Communication functions**

- PG/OP channel: ✓
- Global data communication: ✓
- Number of GD circuits, max.: 4
- Size of GD packets, max.: 22 Byte
- S7 basic communication: ✓
- S7 basic communication, user data per job: 76 Byte
- S7 communication: ✓
- S7 communication as server: ✓
- S7 communication as client: -
- S7 communication, user data per job: 160 Byte
- Number of connections, max.: 16

**Functionality Sub-D interfaces**

- Type: MPI
- Type of interface: RS485
- Connector: Sub-D, 9-pin, female
- Electrically isolated: -
- MPI: ✓
- MPI (MPI/RS232): ✓
- DP master: -
- DP slave: -
- Point-to-point interface: -
**Manual VIPA System 200V**

**Chapter 2  Hardware description**

<table>
<thead>
<tr>
<th>Order no.</th>
<th>214-2BP03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>DP</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>✓</td>
</tr>
<tr>
<td>MPI</td>
<td>-</td>
</tr>
<tr>
<td>MPI (MPI/RS232)</td>
<td>-</td>
</tr>
<tr>
<td>DP master</td>
<td>-</td>
</tr>
<tr>
<td>DP slave</td>
<td>yes</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
</tbody>
</table>

**Functionality MPI**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of connections, max.</td>
<td>16</td>
</tr>
<tr>
<td>MPI/GOP channel</td>
<td>✓</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✓</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>19.2 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>187.5 kbit/s</td>
</tr>
</tbody>
</table>

**Functionality PROFIBUS slave**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PG/GOP channel</td>
<td>-</td>
</tr>
<tr>
<td>Routing</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>Direct data exchange (slave-to-slave communication)</td>
<td>-</td>
</tr>
<tr>
<td>DPV1</td>
<td>-</td>
</tr>
<tr>
<td>Transmission speed, min.</td>
<td>9.6 kbit/s</td>
</tr>
<tr>
<td>Transmission speed, max.</td>
<td>12 Mbit/s</td>
</tr>
<tr>
<td>Automatic detection of transmission speed</td>
<td>-</td>
</tr>
<tr>
<td>Transfer memory inputs, max.</td>
<td>64 Byte</td>
</tr>
<tr>
<td>Transfer memory outputs, max.</td>
<td>64 Byte</td>
</tr>
<tr>
<td>Address areas, max.</td>
<td>1</td>
</tr>
<tr>
<td>User data per address area, max.</td>
<td>64 Byte</td>
</tr>
</tbody>
</table>

**Datasizes**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input bytes</td>
<td>0</td>
</tr>
<tr>
<td>Output bytes</td>
<td>0</td>
</tr>
<tr>
<td>Parameter bytes</td>
<td>16</td>
</tr>
<tr>
<td>Diagnostic bytes</td>
<td>0</td>
</tr>
</tbody>
</table>

**Housing**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material</td>
<td>PPE / PA 6.6</td>
</tr>
<tr>
<td>Mounting</td>
<td>Profile rail 35 mm</td>
</tr>
</tbody>
</table>

**Mechanical data**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions (W x H x D)</td>
<td>50.8 x 76 x 80 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>150 g</td>
</tr>
</tbody>
</table>

**Environmental conditions**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>0 °C to 60 °C</td>
</tr>
<tr>
<td>Storage</td>
<td>-25 °C to 70 °C</td>
</tr>
</tbody>
</table>

**Certifications**

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>UL508 certification</td>
<td>yes</td>
</tr>
</tbody>
</table>
## 215-2BP03

<table>
<thead>
<tr>
<th>Order no.</th>
<th>215-2BP03</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>CPU 215DP</td>
</tr>
<tr>
<td><strong>Technical data power supply</strong></td>
<td></td>
</tr>
<tr>
<td>Power supply (rated value)</td>
<td>DC 24 V</td>
</tr>
<tr>
<td>Power supply (permitted range)</td>
<td>DC 20.4...28.8 V</td>
</tr>
<tr>
<td>Reverse polarity protection</td>
<td>✓</td>
</tr>
<tr>
<td>Current consumption (no-load operation)</td>
<td>100 mA</td>
</tr>
<tr>
<td>Inrush current</td>
<td>65 A</td>
</tr>
<tr>
<td>I²t</td>
<td>0.75 A²s</td>
</tr>
<tr>
<td>Max. current drain at backplane bus</td>
<td>3 A</td>
</tr>
<tr>
<td>Power loss</td>
<td>5 W</td>
</tr>
<tr>
<td><strong>Load and working memory</strong></td>
<td></td>
</tr>
<tr>
<td>Load memory, integrated</td>
<td>192 KB</td>
</tr>
<tr>
<td>Load memory, maximum</td>
<td>192 KB</td>
</tr>
<tr>
<td>Work memory, integrated</td>
<td>128 KB</td>
</tr>
<tr>
<td>Work memory, maximal</td>
<td>128 KB</td>
</tr>
<tr>
<td>Memory divided in 50% program / 50% data</td>
<td>-</td>
</tr>
<tr>
<td>Memory card slot</td>
<td>MMC-Card with max. 512 MB</td>
</tr>
<tr>
<td><strong>Hardware configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Racks, max.</td>
<td>4</td>
</tr>
<tr>
<td>Modules per rack, max.</td>
<td>total max. 32</td>
</tr>
<tr>
<td>Number of integrated DP master</td>
<td>-</td>
</tr>
<tr>
<td>Number of DP master via CP</td>
<td>8</td>
</tr>
<tr>
<td>Operable function modules</td>
<td>32</td>
</tr>
<tr>
<td>Operable communication modules PtP</td>
<td>32</td>
</tr>
<tr>
<td>Operable communication modules LAN</td>
<td>-</td>
</tr>
<tr>
<td><strong>Command processing times</strong></td>
<td></td>
</tr>
<tr>
<td>Bit instructions, min.</td>
<td>0.18 µs</td>
</tr>
<tr>
<td>Word instruction, min.</td>
<td>0.78 µs</td>
</tr>
<tr>
<td>Double integer arithmetic, min.</td>
<td>1.8 µs</td>
</tr>
<tr>
<td>Floating-point arithmetic, min.</td>
<td>40 µs</td>
</tr>
<tr>
<td><strong>Timers/Counters and their retentive characteristics</strong></td>
<td></td>
</tr>
<tr>
<td>Number of S7 counters</td>
<td>256</td>
</tr>
<tr>
<td>S7 counter remanence</td>
<td>adjustable 0 up to 64</td>
</tr>
<tr>
<td>S7 counter remanence adjustable</td>
<td>8</td>
</tr>
<tr>
<td>Number of S7 times</td>
<td>256</td>
</tr>
<tr>
<td>S7 times remanence</td>
<td>adjustable 0 up to 128</td>
</tr>
<tr>
<td>S7 times remanence adjustable</td>
<td>not retentive</td>
</tr>
<tr>
<td><strong>Data range and retentive characteristic</strong></td>
<td></td>
</tr>
<tr>
<td>Number of flags</td>
<td>8192 Bit</td>
</tr>
<tr>
<td>Bit memories retentive characteristic adjustable</td>
<td>adjustable 0 up to 256</td>
</tr>
<tr>
<td>Bit memories retentive characteristic preset</td>
<td>MB0 .. MB15</td>
</tr>
<tr>
<td>Number of data blocks</td>
<td>2047</td>
</tr>
<tr>
<td>Max. data blocks size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range DBs</td>
<td>1 .. 2047</td>
</tr>
<tr>
<td>Max. local data size per execution level</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Max. local data size per block</td>
<td>1024 Byte</td>
</tr>
<tr>
<td><strong>Blocks</strong></td>
<td></td>
</tr>
<tr>
<td>Number of OBs</td>
<td>14</td>
</tr>
<tr>
<td>Maximum OB size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Total number DBs, FBs, FCs</td>
<td>-</td>
</tr>
<tr>
<td>Number of FBs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FB size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FBs</td>
<td>0 .. 1023</td>
</tr>
<tr>
<td>Number of FCs</td>
<td>1024</td>
</tr>
<tr>
<td>Maximum FC size</td>
<td>16 KB</td>
</tr>
<tr>
<td>Number range FCs</td>
<td>0 .. 1023</td>
</tr>
<tr>
<td>Maximum nesting depth per priority class</td>
<td>8</td>
</tr>
<tr>
<td>Maximum nesting depth additional within an error OB</td>
<td>1</td>
</tr>
<tr>
<td><strong>Order no.</strong></td>
<td>215-2BP03</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td></td>
</tr>
<tr>
<td>Real-time clock buffered</td>
<td>✔</td>
</tr>
<tr>
<td>Clock buffered period (min.)</td>
<td>30 d</td>
</tr>
<tr>
<td>Type of buffering</td>
<td>Vanadium Rechargeable Lithium Batterie</td>
</tr>
<tr>
<td>Load time for 50% buffering period</td>
<td>20 h</td>
</tr>
<tr>
<td>Load time for 100% buffering period</td>
<td>48 h</td>
</tr>
<tr>
<td>Accuracy (max. deviation per day)</td>
<td>10 s</td>
</tr>
<tr>
<td>Number of operating hours counter</td>
<td>8</td>
</tr>
<tr>
<td>Clock synchronization</td>
<td>-</td>
</tr>
<tr>
<td>Synchronization via MPI</td>
<td>-</td>
</tr>
<tr>
<td>Synchronization via Ethernet (NTP)</td>
<td>-</td>
</tr>
<tr>
<td><strong>Address areas (I/O)</strong></td>
<td></td>
</tr>
<tr>
<td>Input I/O address area</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Output I/O address area</td>
<td>1024 Byte</td>
</tr>
<tr>
<td>Process image adjustable</td>
<td>-</td>
</tr>
<tr>
<td>Input process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image preset</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Input process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Output process image maximal</td>
<td>128 Byte</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8192</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8192</td>
</tr>
<tr>
<td>Digital inputs central</td>
<td>512</td>
</tr>
<tr>
<td>Digital outputs central</td>
<td>512</td>
</tr>
<tr>
<td>Integrated digital inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated digital outputs</td>
<td>-</td>
</tr>
<tr>
<td>Analog inputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog outputs</td>
<td>512</td>
</tr>
<tr>
<td>Analog inputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Analog outputs, central</td>
<td>128</td>
</tr>
<tr>
<td>Integrated analog inputs</td>
<td>-</td>
</tr>
<tr>
<td>Integrated analog outputs</td>
<td>-</td>
</tr>
<tr>
<td><strong>Communication functions</strong></td>
<td></td>
</tr>
<tr>
<td>PG/OP channel</td>
<td>✔</td>
</tr>
<tr>
<td>Global data communication</td>
<td>✔</td>
</tr>
<tr>
<td>Number of GD circuits, max.</td>
<td>4</td>
</tr>
<tr>
<td>Size of GD packets, max.</td>
<td>22 Byte</td>
</tr>
<tr>
<td>S7 basic communication</td>
<td>✔</td>
</tr>
<tr>
<td>S7 basic communication, user data per job</td>
<td>76 Byte</td>
</tr>
<tr>
<td>S7 communication</td>
<td>✔</td>
</tr>
<tr>
<td>S7 communication as server</td>
<td>✔</td>
</tr>
<tr>
<td>S7 communication as client</td>
<td>-</td>
</tr>
<tr>
<td>S7 communication, user data per job</td>
<td>160 Byte</td>
</tr>
<tr>
<td>Number of connections, max.</td>
<td>16</td>
</tr>
<tr>
<td><strong>Functionality Sub-D interfaces</strong></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>MPI</td>
</tr>
<tr>
<td>Type of interface</td>
<td>RS485</td>
</tr>
<tr>
<td>Connector</td>
<td>Sub-D, 9-pin, female</td>
</tr>
<tr>
<td>Electrically isolated</td>
<td>-</td>
</tr>
<tr>
<td>MPI</td>
<td>✔</td>
</tr>
<tr>
<td>MPI (MPI/RS232)</td>
<td>✔</td>
</tr>
<tr>
<td>DP master</td>
<td>-</td>
</tr>
<tr>
<td>DP slave</td>
<td>-</td>
</tr>
<tr>
<td>Point-to-point interface</td>
<td>-</td>
</tr>
</tbody>
</table>

| **Type** | DP |
| **Type of interface** | RS485 |
| **Connector** | Sub-D, 9-pin, female |
| **Electrically isolated** | ✔ |
| **MPI** | - |
### Order no.
| 215-2BP03 |

### MPI (MPI/RS232)
- 

### DP master
- 

### DP slave
- yes 

### Point-to-point interface
- 

### Functionality MPI
- Number of connections, max. 16
- PG/OP channel ✔
- Routing -
- Global data communication ✔
- S7 basic communication ✔
- S7 communication ✔
- S7 communication as server ✔
- S7 communication as client -
- Transmission speed, min. 19.2 kbit/s
- Transmission speed, max. 187.5 kbit/s 

### Functionality PROFIBUS slave
- PG/OP channel -
- Routing -
- S7 communication -
- S7 communication as server -
- S7 communication as client -
- Direct data exchange (slave-to-slave communication) -
- DPV1 -
- Transmission speed, min. 9.6 kbit/s
- Transmission speed, max. 12 Mbit/s
- Automatic detection of transmission speed -
- Transfer memory inputs, max. 64 Byte
- Transfer memory outputs, max. 64 Byte
- Address areas, max. 1
- User data per address area, max. 64 Byte

### Datasizes
- Input bytes 0
- Output bytes 0
- Parameter bytes 16
- Diagnostic bytes 0

### Housing
- Material PPE / PA 6.6
- Mounting Profile rail 35 mm

### Mechanical data
- Dimensions (WxHxD) 50.8 x 76 x 80 mm
- Weight 150 g

### Environmental conditions
- Operating temperature 0 °C to 60 °C 
- Storage temperature -25 °C to 70 °C

### Certifications
- UL508 certification yes
Chapter 3  Deployment CPU 21x-2BP03

Overview
This chapter describes the deployment of the CPU in the System 200V. The description refers directly to the CPU and to the deployment in connection with peripheral modules, mounted on a profile rail together with the CPU at the backplane bus.

Content

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 3 Deployment CPU 21x-2BP03</td>
<td>3-1</td>
</tr>
<tr>
<td>Assembly</td>
<td>3-2</td>
</tr>
<tr>
<td>Start-up behavior</td>
<td>3-2</td>
</tr>
<tr>
<td>Addressing</td>
<td>3-3</td>
</tr>
<tr>
<td>Hints for the deployment of the MPI interface</td>
<td>3-5</td>
</tr>
<tr>
<td>Hardware configuration - CPU</td>
<td>3-6</td>
</tr>
<tr>
<td>Hardware configuration - I/O modules</td>
<td>3-8</td>
</tr>
<tr>
<td>Setting CPU parameters</td>
<td>3-9</td>
</tr>
<tr>
<td>Project transfer</td>
<td>3-13</td>
</tr>
<tr>
<td>Operating modes</td>
<td>3-17</td>
</tr>
<tr>
<td>Overall reset</td>
<td>3-19</td>
</tr>
<tr>
<td>Firmware update</td>
<td>3-21</td>
</tr>
<tr>
<td>Factory reset</td>
<td>3-23</td>
</tr>
<tr>
<td>VIPA specific diagnostic entries</td>
<td>3-24</td>
</tr>
<tr>
<td>Using test functions for control and monitoring of variables</td>
<td>3-26</td>
</tr>
</tbody>
</table>
**Assembly**

*Note!*
Information about assembly and cabling may be found at chapter “Basics and Assembly”.

**Start-up behavior**

**Turn on power supply**
When the CPU is delivered it has been reset. After the power supply has been switched on, the CPU changes to the operating mode the operating mode lever shows. After a STOP → RUN transition the CPU switches to RUN without program.

*Note!*
Due to a long storage of the CPU, the battery may be discharged excessively. Please connect the CPU at least for 24 hours to the power supply, to achieve the full buffer capacity.

**Boot procedure with valid data in the CPU**
The CPU switches to RUN with the program stored in the battery buffered RAM.

**Boot procedure with empty battery**
The accumulator/battery is automatically loaded via the integrated power supply and guarantees a buffer for max. 30 days. If this time is exceeded, the battery may be totally discharged. This means that the battery buffered RAM is deleted.

In this state, the CPU executes an overall reset because with an empty battery the RAM content is undefined. If a MMC with a S7PROG.WLD is plugged, program code and data blocks are transferred from the MMC into the work memory of the CPU.

If there is no MMC, the project from the internal Flash is loaded.
Depending on the position of the operating mode switch, the CPU remains in STOP respectively switches to RUN. Due to the battery error the CPU can only boot if there was an OB81 configured. Otherwise a manual restart (STOP/RUN) respectively PG command is necessary.

On a start-up with an empty battery the SF LED is on and thus points to an entry in the diagnostic buffer. Information about the Event-IDs can be found at "VIPA specific diagnostic entries".

*Attention!*
After a power reset and with an empty battery the CPU starts with a BAT error and executes an overall reset.
Addressing

Automatic addressing

To provide specific addressing of the installed peripheral modules, certain addresses must be allocated in the CPU.

The CPU contains a peripheral area (addresses 0 ... 1023) and a process image of the inputs and the outputs (for both each address 0 ... 127).

When the CPU is initialized it automatically assigns peripheral addresses to the digital input/output modules starting from 0.

If there is no hardware projecting, analog modules are allocated to even addresses starting from address 128.

Signaling states in the process image

The signaling states of the lower addresses (0 ... 127) are additionally saved in a special memory area called the process image.

The process image is divided into two parts:
- process image of the inputs (PII)
- process image of the outputs (PIQ)

The process image is updated automatically when a cycle has been completed.

Read/write access

You may access the modules by means of read or write operations on the peripheral bytes or on the process image.

Note!

Please remember that you may access different modules by means of read and write operations on the same address.

The addressing ranges of digital and analog modules are different when they are addressed automatically.

Digital modules:    0 ... 127
Analog modules:    128 ... 1023
The following figure illustrates the automatic allocation of addresses:

![Diagram of CPU and peripheral areas]

You may change the allocated addresses at any time by means of the Siemens SIMATIC manager. In this way you may also change the addresses of analog modules to the range covered by the process image (0 ... 127) and address digital modules above 127.

The following pages describe the required preparations and the procedure for this type of configuration.
Hints for the deployment of the MPI interface

What is MP2I?

The MP2I jack combines 2 interfaces in 1:
- MP interface
- RS232 interface

Please regard that the RS232 functionality is only available by using the Green Cable from VIPA.

Deployment as MP interface

The MP interface provides the data transfer between CPUs and PCs. In a bus communication you may transfer programs and data between the CPUs interconnected via MPI.

Connecting a common MPI cable, the MPI jack supports the full MPI functionality.

Important notes for the deployment of MPI cables!

Deploying MPI cables at the CPUs from VIPA, you have to make sure that Pin 1 is not connected. This may cause transfer problems and in some cases damage the CPU!

Especially PROFIBUS cables from Siemens, like e.g. the 6XV1 830-1CH30, must not be deployed at MP2I jack.

For damages caused by nonobservance of these notes and at improper deployment, VIPA does not take liability!

Deployment as RS232 interface only via "Green Cable"

For the serial data transfer from your PC, you normally need a MPI transducer. Fortunately you may also use the "Green Cable" from VIPA. You can order this under the order no. VIPA 950-0KB00.

The "Green Cable" supports a serial point-to-point connection for data transfer via the MP2I jack exclusively for VIPA CPUs.
Hardware configuration - CPU

Overview
For the project engineering of the CPU 21x and the other System 200V modules connected to the same VIPA bus, the hardware configurator from Siemens is to be used.
To address the directly plugged peripheral modules, you have to assign a special address in the CPU to every module.
The address allocation and the parameterization of the modules takes place in the Siemens SIMATIC manager as a virtual PROFIBUS system.
For the PROFIBUS interface is standardized software sided, the functionality is guaranteed by including a GSD-file into the Siemens SIMATIC manager.
Transfer your project into the CPU via the MPI interface.

Requirements
The following conditions must be fulfilled for project engineering:
• The Siemens SIMATIC manager is installed at PC respectively PU
• The GSD files have been included in Siemens hardware configurator
• Serial connection to the CPU (e.g. MPI-Adapter)

Note!
The configuration of the CPU requires a thorough knowledge of the Siemens SIMATIC manager and the hardware configurator!

Including the GSD-file
• Go to www.vipa.com > Service > Download > PROFIBUS GSD files and download the file System_100V_-_200V_Vxxx.zip.
• Extract the file to your work directory. The vipa_21x.gsd (German) respectively vipa_21x.gse (English) can be found at the directory CPU21x.
• Start the Siemens hardware configurator and close every project.
• Go to Options > Install new GSD file
• Navigate to the directory CPU21x and choose the corresponding file vipa_21x.gsd (German) or vipa_21x.gse (English)
Now the modules of the VIPA System 200V are integrated in the hardware catalog at PROFIBUS-DP \ Additional field devices \ I/O \ VIPA_System_200V.
To be compatible with the Siemens SIMATIC manager the following steps should be executed:

- Start the hardware configurator from Siemens with a new project.
- Insert a profile rail from the hardware catalog.
- Place at slot 2 the following CPU from Siemens: **CPU 315-2DP (315-2AF03 0AB00 V1.2)**
- For the System 200V create a new PROFIBUS subnet.
- Attach the slave system "VIPA_CPU21x" to the subnet with **PROFIBUS-Address 1**. After installing the vipa_21x.gsd the slave system may be found at the hardware catalog at PROFIBUS DP > Additional field devices > IO > VIPA_System_200V.
- Place **always at the 1. slot** the corresponding CPU 21x-2BP03, by taking it from the hardware catalog.
Hardware configuration - I/O modules

Hardware configuration of the modules

After the hardware configuration of the CPU place the System 200V modules in the plugged sequence.
In order to address the installed peripheral modules individually, specific addresses in the CPU have to be assigned to them.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CPU 21x</td>
</tr>
<tr>
<td>2</td>
<td>DI 8xDC24V</td>
</tr>
<tr>
<td>3</td>
<td>DO 8xDC24V</td>
</tr>
<tr>
<td>4</td>
<td>DIO 8xDC24V</td>
</tr>
<tr>
<td>5</td>
<td>AI 4x12Bit</td>
</tr>
<tr>
<td>6</td>
<td>AO 4x12Bit</td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>

Parameter DIO

For parameterization double-click during the project engineering at the slot overview on the module you want to parameterize. In the appearing dialog window you may set the wanted parameters.

Parameterization during runtime

By using the SFCs 55, 56 and 57 you may alter and transfer parameters for wanted modules during runtime.
For this you have to store the module specific parameters in so called "record sets".
More detailed information about the structure of the record sets is to find in the according module description.
Setting CPU parameters

Parameterization via Siemens CPU 315-2AF03

Since the CPU from VIPA is to be configured as Siemens CPU 315-2DP (315-2AF03 0AB00 V1.2) in the Siemens hardware configurator, the parameters of the VIPA CPU may be set with "Object properties" of the CPU 315-2DP during hardware configuration.

Via a double-click on the CPU 315-2DP the parameter window of the CPU may be accessed.

Using the registers you get access to every standard parameter of the CPU.

The CPU does not evaluate each parameter, which may be set at the hardware configuration.

The following parameters are supported by the CPU at this time:

**General**

Short description

The short description of the Siemens CPU 315-2AF03 is CPU 315-2DP.

Order No. / Firmware

Order number and firmware are identical to the details in the "hardware catalog" window.

Name

The Name field provides the short description of the CPU. If you change the name the new name appears in the Siemens SIMATIC manager.

Comment

In this field information about the module may be entered.

**Startup**

Startup when expected/actual configuration differs

If the checkbox for "Startup when expected/actual configuration differ" is deselected and at least one module is not located at its configured slot or if another type of module is inserted there instead, then the CPU does not switch to RUN mode and remains in STOP mode.

If the checkbox for "Startup when expected/actual configuration differ" is selected, then the CPU starts even if there are modules not located in their configured slots of if another type of module is inserted there instead, such as during an initial system start-up.
This operation specifies the maximum time for the ready message of every configured module after PowerON. Here connected PROFIBUS DP slaves are also considered until they are parameterized. If the modules do not send a ready message to the CPU by the time the monitoring time has expired, the actual configuration becomes unequal to the preset configuration.

The maximum time for the transfer of parameters to parameterizable modules. If not every module has been assigned parameters by the time this monitoring time has expired; the actual configuration becomes unequal to the preset configuration.

This parameter is not relevant.

Here the scan cycle monitoring time in milliseconds may be set. If the scan cycle time exceeds the scan cycle monitoring time, the CPU enters the STOP mode. Possible reasons for exceeding the time are:
- Communication processes
- a series of interrupt events
- an error in the CPU program

This parameter is not relevant.

Using this parameter you can control the duration of communication processes, which always extend the scan cycle time so it does not exceed a specified length.

If the cycle load from communication is set to 50%, the scan cycle time of OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still being influenced by asynchronous events (e.g. hardware interrupts) as well.

The preset reaction of the CPU may be changed to an I/O access error that occurs during the update of the process image by the system.
The VIPA CPU is preset such that OB 85 is not called if an I/O access error occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.
Retentive Memory

Number of Memory Bytes from MB0 Enter the number of retentive memory bytes from memory byte 0 onwards.

Number of S7 Timers from T0 Enter the number of retentive S7 timers from T0 onwards. Each S7 timer occupies 2 bytes.

Number of S7 Counters from C0 Enter the number of retentive S7 counter from C0 onwards.

Areas These parameters are not relevant.

Interrupts

Priority Here the priorities are displayed, according to which the hardware interrupt OBs are processed (hardware interrupt, time-delay interrupt, async. error interrupts).

Time-of-day interrupts

Priority Here the priorities may be specified according to which the time-of-day interrupt is processed. With priority "0" the corresponding OB is deactivated.

Active Activate the check box of the time-of-day interrupt OBs if these are to be automatically started on complete restart.

Execution Select how often the interrupts are to be triggered. Intervals ranging from every minute to yearly are available. The intervals apply to the settings made for start date and time.

Start date / time Enter date and time of the first execution of the time-of-day interrupt.

Process image partition This parameter is not supported.

Cyclic interrupts

Priority Here the priorities may be specified according to which the corresponding cyclic interrupt is processed. With priority "0" the corresponding interrupt is deactivated.
### Execution
Enter the time intervals in ms, in which the watchdog interrupt OBs should be processed. The start time for the clock is when the operating mode switch is moved from STOP to RUN.

### Phase offset
Enter the delay time in ms for current execution for the watch dog interrupt. This should be performed if several watchdog interrupts are enabled. Phase offset allows to distribute processing time for watchdog interrupts across the cycle.

### Process image partition
This parameter is not supported.

### Protection
Here 1 of 3 protection levels may be set to protect the CPU from unauthorized access.

- **Protection level 1 (default setting):**
  - No password adjustable, no restrictions

- **Protection level 2 with password:**
  - Authorized users: read and write access
  - Unauthorized user: read access only

- **Protection level 3:**
  - Authorized users: read and write access
  - Unauthorized user: no read and write access
Project transfer

Overview
There are the following possibilities for project transfer into the CPU:
- Transfer via MPI
- Transfer via MMC when using a MMC programmer

Transfer via MPI
The structure of a MPI net is electrically identical with the structure of a PROFIBUS net. This means the same rules are valid and you use the same components for the build-up. The single participants are connected with each other via bus interface plugs and PROFIBUS cables. Per default the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI address 2.

MPI programming cable
The MPI programming cables are available at VIPA in different variants. The cables provide a RS232 res. USB plug for the PC and a bus enabled RS485 plug for the CPU.
Due to the RS485 connection you may plug the MPI programming cables directly to an already plugged plug on the RS485 jack. Every bus participant identifies itself at the bus with an unique address, in the course of the address 0 is reserved for programming devices.

Terminating resistor
A cable has to be terminated with its surge impedance. For this you switch on the terminating resistor at the first and the last participant of a network or a segment.
Please make sure that the participants with the activated terminating resistors are always power supplied. Otherwise it may cause interferences on the bus.

Transfer with MPI programming cable (MPI communication)

Transfer via Green Cable (serial communication)
Via exclusively direct plugging of the Green Cable to a MP²I jack you may establish a serial connection between PC and CPU. Set the PC-COM port and the transfer rate 38400Baud at Local port. The settings of the register MPI are ignored at employment of the Green Cable.
Configure MPI

Hints for configuring a MPI interface are to find in the documentation of your programming software.
The "Green Cable" has the order number VIPA 950-0KB00.

Attention!
Please regard, that you may use the "Green Cable" exclusively at VIPA CPUs with MP2I-interface!
Please regard the hints for deploying the Green Cable and the MP2I jack!

Approach transfer via MPI interface

• Connect your PC to the MPI jack of your CPU via a MPI programming cable.
• Load your project in the SIMATIC manager from Siemens.
• Choose in the menu Options > Set PG/PC interface
• Select in the according list the "PC Adapter (MPI)"; if appropriate you have to add it first, then click on [Properties].
• Set in the register MPI the transfer parameters of your MPI net and type a valid address.
• Switch to the register Local connection
• Set the COM port of the PC and the transfer rate 38400Baud for the MPI programming cable from VIPA.
• Via PLC > Load to module you may transfer your project via MPI to the CPU and save it on a MMC via PLC > Copy RAM to ROM if one is plugged.

Note!
Please make sure to adjust the transfer rate to 38400Baud when using the "Green Cable" from VIPA.
Hints for the Green Cable

The Green Cable is a green connection cable, manufactured exclusively for the deployment at VIPA System components.

The Green Cable is a programming and download cable for VIPA CPUs MP²I jack and VIPA field bus masters. The Green Cable from VIPA is available under the order no. VIPA 950-0KB00.

The Green Cable allows you to:

- **transfer projects serial**
  Avoiding high hardware needs (MPI transducer, etc.) you may realize a serial point-to-point connection via the Green Cable and the MP²I jack. This allows you to connect components to your VIPA-CPU that are able to communicate serial via a MPI adapter like e.g. a visualization system.

- **execute firmware updates of the CPUs and field bus masters**
  Via the Green Cable and an upload application you may update the firmware of all recent VIPA CPUs with MP²I jack and certain field bus masters (see Note).

---

Important notes for the deployment of the Green Cable

Nonobservance of the following notes may cause damages on system components.

For damages caused by nonobservance of the following notes and at improper deployment, VIPA does not take liability!

---

Note to the application area

The Green Cable may exclusively deployed directly at the concerning jacks of the VIPA components (in between plugs are not permitted). E.g. a MPI cable has to be disconnected if you want to connect a Green Cable.

At this time, the following components support Green Cable:

- VIPA CPUs with MP²I jack and field bus masters from VIPA.

---

Note to the lengthening

The lengthening of the Green Cable with another Green Cable res. The combination with further MPI cables is not permitted and causes damages of the connected components!

The Green Cable may only be lengthened with a 1:1 cable (all 9 pins are connected 1:1).
The MMC (Memory Card) serves as external transfer and storage medium. There may be stored several projects and sub-directories on a MMC storage module. Please regard that your current project is stored in the root directory and has one of the following file names:

- S7PROG.WLD
- S7PROGF.WLD
- AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC manager a new wld file may be created. After the creation copy the blocks from the project blocks folder and the System data into the wld file.

The transfer of the application program from the MMC into the CPU takes place depending on the file name after an overall reset or PowerON.

- S7PROG.WLD is read from the MMC after overall reset and transferred into the battery buffered RAM.
- S7PROGF.WLD is read from the MMC after overall reset and transferred into the battery buffered RAM and additionally into the Flash memory. An access to the Flash memory only takes place at empty battery of the buffer and when no MMC with user program is plugged-in.
- AUTOLOAD.WLD is read after PowerON from the MMC and transferred into the battery-buffered RAM.

During the transfer the "MC" LED blinks. Please regard that your user memory serves for enough space, otherwise your user program is not completely loaded and the SF LED gets on. Execute a compression before the transfer, for this does not happen automatically.

When the MMC has been installed, the write command stores the content of the battery buffered RAM as S7PROG.WLD on the MMC and in the internal Flash memory.

The write command is controlled by means of the block area of the Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write process the "MC"-LED of the CPU is blinking. When the LED expires the write process is finished.

If this project is to be loaded automatically from the MMC with PowerON, you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the CPU. To monitor the diagnosis entries, you select PLC > Module Information in the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you reach the diagnosis window.

Information about the Event-IDs can be found at "VIPA specific diagnostic entries".
Operating modes

Overview

The CPU can be in one of 3 operating modes:

- Operating mode STOP
- Operating mode START-UP
- Operating mode RUN

Certain conditions in the operating modes START-UP and RUN require a specific reaction from the system program. In this case the application interface is often provided by a call to an organization block that was included specifically for this event.

Operating mode STOP

- The application program is not processed.
- If there has been a processing before, the values of counters, timers, flags and the process image are retained during the transition to the STOP mode.
- Outputs are inhibited, i.e. all digital outputs are disabled.
- RUN-LED (R) off
- STOP-LED (S) on

Operating mode START-UP

- During the transition from STOP to RUN the system calls the start-up organization block OB 100. The processing time for this OB is not monitored. The start-up OB may issue calls to other blocks.
- All digital outputs are disabled during the start-up, i.e. outputs are inhibited.
- RUN-LED blinks as soon as the OB 100 is operated and for at least 3s, even if the start-up time is shorter or the CPU gets to STOP due to an error. This indicates the start-up.
- STOP-LED off
When the CPU has completed the start-up OB, it assumes the operating mode RUN.

Operating mode RUN

- The application program in OB 1 is processed in a cycle. Under the control of alarms other program sections can be included in the cycle.
- All timers and counters being started by the program are active and the process image is updated with every cycle.
- The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs are enabled.
- RUN-LED on
- STOP-LED off
**Function security**

The CPUs include security mechanisms like a watchdog (100ms) and a parameterizable cycle time surveillance (parameterizable min. 1ms) that stop res. execute a RESET at the CPU in case of an error and set it into a defined STOP state.

The VIPA CPUs are developed function secure and have the following system properties:

<table>
<thead>
<tr>
<th>Event</th>
<th>concerns</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN → STOP</td>
<td>general</td>
<td>BASP (Befehls-Ausgabe-Sperre, i.e. command output lock) is set.</td>
</tr>
<tr>
<td></td>
<td>central digital outputs</td>
<td>The outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The Outputs are disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Voltage outputs issue 0V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Current outputs 0...20mA issue 0mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Current outputs 4...20mA issue 4mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If configured also substitute values may be issued.</td>
</tr>
<tr>
<td></td>
<td>decentral digital outputs</td>
<td>Same behavior as the central digital/analog outputs.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
<tr>
<td>STOP → RUN</td>
<td>general</td>
<td>First the PII is deleted, then OB 100 is called. After the execution of the OB, the BASP is reset and the cycle starts with: Delete PIO → Read PII → OB 1.</td>
</tr>
<tr>
<td>res. PowerON</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>central analog outputs</td>
<td>The behavior of the outputs at restart can be preset.</td>
</tr>
<tr>
<td></td>
<td>decentral inputs</td>
<td>The inputs are cyclically be read by the decentralized station and the recent values are put at disposal.</td>
</tr>
</tbody>
</table>

**RUN**

| general | The program execution happens cyclically and can therefore be foreseen: Read PII → OB 1 → Write PIO. |

PII = Process image inputs
PIO = Process image outputs
Overall reset

Overview

During the overall reset the entire user memory is erased. Data located in the memory card is not affected.

You have 2 options to initiate an overall reset:

- initiate the overall reset by means of the function selector switch
- initiate the overall reset by means of the configuration software e.g. Siemens SIMATIC manager

Note!

You should always issue an overall reset to your CPU before loading an application program into your CPU to ensure that all blocks have been cleared from the CPU.

Overall reset by means of the function selector

Condition

The operating mode of the CPU is STOP. Place the function selector on the CPU in position "ST" → the S-LED is on.

Overall reset

- Place the function selector in the position MR and hold it in this position for app. 3 seconds. → The S-LED changes from blinking to permanently on.
- Place the function selector in the position ST and switch it to MR and quickly back to ST within a period of less than 3 seconds. → The S-LED blinks (overall reset procedure).
- The overall reset has been completed when the S-LED is on permanently. → The S-LED is on.

The following figure illustrates the above procedure:
### Automatic reload

If there is a project S7PROG.WLD on the MMC, the CPU attempts to reload this project from MMC → the MC LED is on. When the reload has been completed the LED is extinguished. The operating mode of the CPU will be STOP or RUN, depending on the position of the function selector.

### Overall reset by means of the Siemens SIMATIC manager

**Condition**

The operating mode of the CPU must be STOP.

You may place the CPU in STOP mode by the menu command **PLC > Operating mode**.

**Overall reset**

You may request the overall reset by means of the menu command **PLC > Clean/Reset**.

In the dialog window you may place your CPU in STOP mode and start the overall reset if this has not been done as yet.

The S-LED blinks during the overall reset procedure.

When the S-LED is on permanently the overall reset procedure has been completed.

### Automatic reload

At this point the CPU attempts to reload the parameters and the program from the memory card. → The MC LED is on.

When the reload has been completed, the LED expires. The operating mode of the CPU will be STOP or RUN, depending on the position of the function selector.

### Reset to factory setting

A Factory reset deletes the internal RAM of the CPU completely and sets it back to the delivery state.

Please regard that the MPI address is also set back to default 2!

More information may be found at the part "Factory reset" further below.
Firmware update

Overview
There is the opportunity to execute a firmware update for the CPU and its components via MMC. For this an accordingly prepared MMC must be in the CPU during the startup.

So a firmware files can be recognized and assigned with startup, a file name is reserved for each updateable component (see table below).

After PowerON and CPU STOP the CPU checks if there is a firmware file on the MMC. If this firmware version is different to the existing firmware version, this is indicated by blinking of the LEDs and the firmware may be installed by an update request.

Latest Firmware at www.vipa.com
The latest firmware versions are to be found in the service area at www.vipa.com

Find out CPU firmware version
A label on the rear of the module indicates the firmware version.

You may display the current firmware version of your CPU via the Siemens SIMATIC manager. To display the firmware version, you go online with the CPU via your PG or PC and start the Siemens SIMATIC manager.

Via PLC > Module status, register "General", the current firmware version is evaluated and displayed.

Load firmware and transfer it to MMC with reserved file name
- Go to www.vipa.com
- Click on Service > Download > Firmware.
- Navigate to via System 200V > CPU to your CPU and download according to your hardware version the zip file to your PC.
- Open the zip file and copy the bin file to your MMC.
- Rename this accordingly

Reserved file names
By means of a reserved file name in the CPU 21x-2BP03 you may transfer a firmware per MMC:

<table>
<thead>
<tr>
<th>Component</th>
<th>File name</th>
<th>New file name at MMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Bx000... .bin</td>
<td>firmware.bin</td>
</tr>
</tbody>
</table>
Attention!

When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the CPU, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Transfer firmware from MMC into CPU

1. Switch the operating mode switch of your CPU in position ST. Turn off the voltage supply. Plug the MMC with the firmware files into the CPU. Please take care of the correct plug-in direction of the MMC. Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and FC shows that at least a differing firmware file was found on the MMC.

3. You start the transfer of the firmware as soon as you tip the operating mode switch lever downwards to MR within 10s and leave it in ST position.

4. During the update process, the LEDs SF and FC are alternately blinking and MC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PW, S, SF, FC and MC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether further current firmware versions are available at the MMC. If so, again the LEDs SF and FC flash after a short start-up period. Continue with point 3.

If the LEDs do not flash, the firmware update is ready.

Now a factory reset should be executed (see next page). After that the CPU is ready for duty.
Factory reset

Proceeding

With the following proceeding the internal RAM of the CPU is completely deleted and the CPU is reset to delivery state.

Please note that here also the MPI address is reset to the address 2!

1. Switch the CPU to STOP.
2. Push the operating mode switch down to position MR for 30s. Here the S LED flashes. After a few seconds the stop LED changes to static light. Now the S LED changes between static light and flashing. Starting here count the static light states of the S LED.
3. After the 6. static light release the operating mode switch and tip it downwards to MR. Now the RUN LED lights up once. This means that the RAM was deleted completely.
4. For the confirmation of the resetting procedure the LEDs PW and S are on.
5. Then you have to switch the power supply off and on.

The proceeding is shown in the following Illustration:

Note!

After the firmware update you always should execute a Factory reset.
VIPA specific diagnostic entries

Entries in the diagnostic buffer
You may read the diagnostic buffer of the CPU via the Siemens SIMATIC manager. Besides of the standard entries in the diagnostic buffer, the VIPA CPUs support some additional specific entries in form of event-IDs.

Monitoring the diagnostic entries
To monitor the diagnostic entries you choose the option **PLC > Module Information** in the Siemens SIMATIC manager. Via the register "Diagnostic Buffer" you reach the diagnostic window:

![Diagnostic Buffer Window]

The diagnosis is independent from the operating mode of the CPU. You may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
## Overview of the Event-IDs

<table>
<thead>
<tr>
<th>Event-ID</th>
<th>Description</th>
</tr>
</thead>
</table>
| 0xE003   | Error at access to I/O devices  
Zinfo1: I/O address  
Zinfo2: Slot |
| 0xE004   | Multiple parameterization of a I/O address  
Zinfo1: I/O address  
Zinfo2: Slot |
| 0xE005   | Internal error – Please contact the VIPA-Hotline! |
| 0xE006   | Internal error – Please contact the VIPA-Hotline! |
| 0xE007   | Configured in-/output bytes do not fit into I/O area |
| 0xE008   | Internal error – Please contact the VIPA-Hotline! |
| 0xE009   | Error at access to standard back plane bus |
| 0xE010   | Not defined module group at backplane bus recognized  
Zinfo2: Slot  
Zinfo3: Type ID |
| 0xE011   | Master project engineering at Slave-CPU not possible or wrong slave configuration |
| 0xE012   | Error at parameterization |
| 0xE013   | Error at shift register access to VBUS digital modules |
| 0xE014   | Error at Check_Sys |
| 0xE015   | Error at access to the master  
Zinfo2: Slot of the master (32=page frame master) |
| 0xE016   | Maximum block size at master transfer exceeded  
Zinfo1: I/O address  
Zinfo2: Slot |
| 0xE017   | Error at access to integrated slave |
| 0xE018   | Error at mapping of the master I/O devices |
| 0xE019   | Error at standard back plane bus system recognition |
| 0xE01A   | Error at recognition of the operating mode (8 / 9 Bit) |
| 0xE0CC   | Communication error MPI / Serial |
| 0xE100   | MMC access error |
| 0xE101   | MMC error file system |
| 0xE102   | MMC error FAT |
| 0xE104   | MMC error at saving |
| 0xE200   | MMC writing finished (Copy Ram to Rom) |
| 0xE210   | MMC reading finished (reload after overall reset) |
| 0xE300   | Internal Flash writing ready (Copy RAM to ROM) |
| 0xE310   | Internal Flash reading finished (reload after battery failure) |
Using test functions for control and monitoring of variables

Overview
For troubleshooting purposes and to display the status of certain variables you can access certain test functions via the menu item **Debug** of the Siemens SIMATIC manager.
The status of the operands and the VKE can be displayed by means of the test function **Debug > Monitor**.
You can modify and/or display the status of variables by means of the test function **PLC > Monitor/Modify Variables**.

**Debug > Monitor**
This test function displays the current status and the VKE of the different operands while the program is being executed.
It is also possible to enter corrections to the program.

**Note!**
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of the states may be interrupted by means of jump commands or by timer and process-related alarms. At the breakpoint the CPU stops collecting data for the status display and instead of the required data it only provides the PG with data containing the value 0.
For this reason, jumps or time and process alarms can result in the value displayed during program execution remaining at 0 for the items below:

- the result of the logical operation VKE
- Status / AKKU 1
- AKKU 2
- Condition byte
- absolute memory address SAZ. In this case SAZ is followed by a “?”.

The interruption of the processing of statuses does not change the execution of the program. It only shows that the data displayed is no longer.
This test function returns the condition of a selected operand (inputs, outputs, flags, data word, counters or timers) at the end of program-execution.

This information is obtained from the process image of the selected operands. During the "processing check" or in operating mode STOP the periphery is read directly from the inputs. Otherwise only the process image of the selected operands is displayed.

**Control of outputs**

It is possible to check the wiring and proper operation of output-modules. You can set outputs to any desired status with or without a control program. The process image is not modified but outputs are no longer inhibited.

**Control of variables**

The following variables may be modified:

I, Q, M, T, C and D.

The process image of binary and digital operands is modified independently of the operating mode of the CPU.

When the operating mode is RUN the program is executed with the modified process variable. When the program continues they may, however, be modified again without notification.

Process variables are controlled asynchronously to the execution sequence of the program.
## Chapter 4  PROFIBUS communication

### Overview
This chapter describes applications of the CPU 21x-2BP03 with PROFIBUS. You'll get all information for the deployment of an intelligent PROFIBUS DP slave.

### Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4 PROFIBUS communication</td>
<td>4-1</td>
</tr>
<tr>
<td>Overview</td>
<td>4-2</td>
</tr>
<tr>
<td>Deployment as PROFIBUS DP slave</td>
<td>4-3</td>
</tr>
<tr>
<td>DP slave parameters</td>
<td>4-6</td>
</tr>
<tr>
<td>Diagnostic functions</td>
<td>4-8</td>
</tr>
<tr>
<td>Internal status messages to CPU</td>
<td>4-11</td>
</tr>
<tr>
<td>PROFIBUS installation guidelines</td>
<td>4-13</td>
</tr>
<tr>
<td>Example</td>
<td>4-16</td>
</tr>
</tbody>
</table>
Overview

PROFIBUS DP

PROFIBUS is an international standard applicable to an open and serial field bus for building, manufacturing and process automation that can be used to create a low (sensor-/actuator level) or medium (process level) performance network of programmable logic controllers.

PROFIBUS comprises an assortment of compatible versions. The following details refer to PROFIBUS DP.

PROFIBUS DP is a special protocol intended mainly for automation tasks in a manufacturing environment. DP is very fast, offers Plug’n’Play facilities and provides a cost-effective alternative to parallel cabling between PLC and remote I/O. PROFIBUS DP was designed for high-speed data communication on the sensor-actuator level.

The data transfer referred to as "Data Exchange" is cyclical. During one bus cycle, the master reads input values from the slaves and writes output information to the slave.

DP slave operation

For the deployment in a super-ordinated master system you first have to project your slave system as virtual PROFIBUS system with connected slave and configured I/O area.

Afterwards you configure your master system. Connect to your master system your slave system by installing the VIPA04D5.gsd and by dragging the "VIPA_CPU2xxDP" from the hardware catalog onto the master system, choose your slave system and connect it.

Define for the PROFIBUS communication the I/O areas. These must be identical for master and slave system. Please regard that a slave output area relates to a master input area and vice versa.

Firmware update

The firmware update of the integrated PROFIBUS part happens automatically by the firmware update of the CPU.

On delivery

On delivery the CPU is overall reset. The PROFIBUS part is deactivated after PowerON.

Behavior at CPU STOP

With every change of the RUN STOP state of the CPU, the DP slave sends a diagnostics telegram to the subordinated DP master. Independent on the CPU state the DP slave remains in data exchange.
Deployment as PROFIBUS DP slave

Overview

In contrast to the VIPA PROFIBUS coupler IM 253DP, the PROFIBUS coupler in the CPU 21xDP is an "intelligent coupler". The "intelligent coupler" processes data that is available from an input or an output area of the CPU. This area and an area for status and diagnostic data are fixed via the CPU 21xDP properties. Separate memory areas are used for input and for output data. Those areas are to handle with your PLC program.

Due to the system, the address areas occupied by the coupler are not displayed in the hardware configurator from Siemens. For the directly plugged-in System 200V modules are also included in the periphery address range, there may occur address overlappings during the automatic address allocation.

Note!

For configuring the CPU and the PROFIBUS DP master a thorough knowledge of the Siemens SIMATIC manager and the hardware configurator from Siemens is required!

Fast introduction

To be compatible with the Siemens SIMATIC manager, you have to execute the following steps for the System 200V:

Slave part

• Project the CPU 315-2DP with DP master system (address 2).
• Add the PROFIBUS slave "VIPA_CPU21x" from the VIPA_21x.gsd with address 1.
• Include the CPU 21x-2BP03 at the 1. slot of the slave system.
• Adjust the PROFIBUS parameters of the CPU 21x-2BP03.
• Include directly plugged-in periphery modules at the following slots.
• Transfer project into the CPU 21x-2BP03.

Master part

• Configure a new SIMATIC 300 Object
• Configure a CPU with a new DP master system (address 2).
• Add the PROFIBUS slave "VIPA_CPU2xxDP" from the VIPA04D5.gsd.
• Set the PROFIBUS in- and output ranges starting with the 1. slot. Please regard that the length settings at the slave must be congruent to the Byte settings in the master!
• Set the PROFIBUS address to the same address you have set in the slave system.

Attention!

The length values for in- and output area have to be identical to the byte values of the master configuration. Otherwise there is no PROFIBUS communication possible and the master notes a slave failure!
Configuration of the slave part

- Start the Siemens SIMATIC manager and configure a CPU as described at "Hardware configuration - CPU".
- Designate the station as "...DP slave"
- Add your modules according to the real hardware assembly.
- Open the properties dialog of the CPU 21x-2BP03 by means of a double-click to this CPU.
- Configure the Device specific parameters, by setting the PROFIBUS address and the areas for input and output data.
- Save, compile and transfer your project to your CPU.

More information about the parameters of the CPU 21x-2BP03 may be found further below at "DP slave parameter".

**Input addr, len**
Address, from where on the data coming from PROFIBUS shall be stored in the CPU, together with the according length.

**Output addr, len**
Address, from where on the data are stored that shall be send via PROFIBUS. Here also you predefine the data length via len.
The length value of 0 occupies no CPU memory space for the input area.

**Note!**
The length value of 0 occupies no CPU memory space for the according area.

**PROFIBUS DP address**
Via this parameter you assign a PROFIBUS address to your PROFIBUS slave. This address must be the same as configured in the master system.
For configuration in a leading master system, the installation of the GSD file vipa04d5.gsd is required.

- Configure your the PROFIBUS DP master, which will be the superordinate system of your CPU 21xDP.
- Configure a new PROFIBUS subnet.
- Add a DP slave of the station type "CPU2xxDP". This is to find in the hardware catalog at PROFIBUS DP > Additional field devices > I/O > VIPA > VIPA_CPU2xxDP.
- Assign the PROFIBUS address to the DP slave that you've parameterized at the slave part for the CPU 21x-2PB03.
- For the PROFIBUS communication, create the same I/O range that you’ve parameterized at the slave in form of "modules". Please regard that a slave output area relates to a master input area and vice versa.
- Save your project and transfer it into the CPU of your master system.

**Note!**
If your DP master system is a System 200V module from VIPA, you may parameterize the directly plugged-in modules by including a “DP200V” slave system.
To enable the VIPA CPU to recognize the project as central system, you have to assign the PROFIBUS address 1 to your slave system!

Please take care at deployment of the IM 208 PROFIBUS DP master that this has a firmware version V 3.0 or higher; otherwise this may not be used at a CPU 21x with a firmware version V 3.0 or higher. The firmware versions are on a label at the backside of the modules.
DP slave parameters

Overview

With an "intelligent slave", the PROFIBUS section writes its data areas into the memory area of the CPU 21x-2BP03. The assignment of the areas happens via the "properties" of the CPU 21x-2BP03. The input or output areas have to be supported with an according PLC program.

Slave: (VIPA_CPU21x from VIPA_21x.gsd)

Master: (VIPA_CPU2xxDP from VIPA04D5.gsd)

Attention!

The length values for in- and output area have to be identical to the byte values of the master configuration. Otherwise there is no PROFIBUS communication possible and the master reports a slave failure!

Parameter data CPU 21x-2BP03

Via a double-click at the CPU 21x-2BP03 in the hardware configurator from Siemens, a dialog window for configuration of the PROFIBUS slave data areas appears.

Input addr, len

Address, from where on the data coming from PROFIBUS shall be stored in the CPU, together with the according length.

Output addr, len

Address, from where on the data are stored that shall be send via PROFIBUS. Here also you predefine the data length via len.

Note!

The length value of 0 occupies no CPU memory space for the input area.
The parameter data are an extract of the parameter telegram. The parameter telegram is created during the master configuration and is sent to the slave when:

- the CPU 21xDP is in start-up
- the connection between CPU 21xDP and master has been interrupted, like e.g. short-time release of the bus connector.

A parameter telegram exists of PROFIBUS-specific data (bus parameters) and user specific data, where at the CPU 21xDP the in- and output bytes are defined.

The user specific data (Byte 7...31) is mapped into the memory area of the CPU with a fixed length of 24Byte, starting from the address fixed under `prm`

Thus you may proof the parameters your slave is getting from the master.

The various diagnostic functions of PROFIBUS DP allow a fast error detection and localization. The diagnostic messages are transferred via the bus and collected at the master.

The CPU 21xDP is sending diagnostic data at request from the master or in case of an error. The diagnostic data consists of:

- Norm diagnostic data (Byte0...5),
- Device-related diagnostic data (Byte6...10)
- **User-specific diagnostic data (Byte11...15)**

Via `diag` you define the start address, from where on the 6Byte user-specific diagnostic data shall be stored in the CPU.

You may initiate and influence diagnostics by controlled access to this area.

**Note!**

More detailed information about the structure and the control possibilities on diagnostic messages are to find under "Diagnostic functions".

The recent state of the PROFIBUS communication is readable from a 2Byte status area in the periphery address area of the CPU, starting from the status address.

**Note!**

More detailed information about the structure of a status message is to find under "Status message internal to CPU".

Via this parameter you assign a PROFIBUS address to your PROFIBUS system.
Diagnostic functions

Overview

PROFIBUS-DP is provided with an extensive set of diagnostic functions that may be used to locate problems quickly and effectively. Diagnostic messages are transferred via the bus and collected by the master.

The CPU 21xDP transmits diagnostic data when requested by the master or when an error occurs. Since a portion of the diagnostic data (Byte11...15) is located in the peripheral address area of the CPU, you may start the diagnostics and modify the diagnostic data. Diagnostic data consists of:

- standard diagnostic data (Byte 0.. 5),
- equipment related diagnostic data (Byte 6...15).

Structure

The structure of the diagnostic data is as follows:

<table>
<thead>
<tr>
<th>Standard diagnostic data</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte 0 Station status 1</td>
<td></td>
</tr>
<tr>
<td>Byte 1 Station status 2</td>
<td></td>
</tr>
<tr>
<td>Byte 2 Station status 3</td>
<td></td>
</tr>
<tr>
<td>Byte 3 Master address</td>
<td></td>
</tr>
<tr>
<td>Byte 4 Ident number (low)</td>
<td></td>
</tr>
<tr>
<td>Byte 5 Ident number (high)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Device related diagnostic data</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte 6 Length and code of device related</td>
<td></td>
</tr>
<tr>
<td>diagnostics</td>
<td></td>
</tr>
<tr>
<td>Byte 7 Equipment related diagnostic</td>
<td></td>
</tr>
<tr>
<td>messages</td>
<td></td>
</tr>
<tr>
<td>Byte 8 ... Byte 10 reserved</td>
<td></td>
</tr>
<tr>
<td>Byte 11 ... Byte 15 User-specific</td>
<td></td>
</tr>
<tr>
<td>diagnostic data is mapped into the</td>
<td></td>
</tr>
<tr>
<td>peripheral addressing range of the CPU and</td>
<td></td>
</tr>
<tr>
<td>may be modified and sent to the master.</td>
<td></td>
</tr>
</tbody>
</table>
Details on the structure of the standard diagnostic data are available from the literature on the PROFIBUS standards. This documentation is available from the PROFIBUS User Organization.

The slave standard diagnostic data have the following structure:

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit 7 ... Bit 0</th>
</tr>
</thead>
</table>
| 0    | Bit 0: fixed at 0  
      | Bit 1: slave not ready for data transfer  
      | Bit 2: configuration data is not identical  
      | Bit 3: slave got extern diagnostic data  
      | Bit 4: slave does not provide this function  
      | Bit 5: fixed at 0  
      | Bit 6: wrong parameterization  
      | Bit 7: fixed at 0  |
| 1    | Bit 0: slave needs new parameterization  
      | Bit 1: statistical diagnosis  
      | Bit 2: fixed at 1  
      | Bit 3: response control active  
      | Bit 4: freeze command received  
      | Bit 5: sync command received  
      | Bit 6: reserved  
      | Bit 7: fixed at 0  |
| 2    | Bit 0...Bit 6: reserved  
      | Bit 7: Diagnostic data overflow  |
| 3    | Master address after parameterization  
      | FFh: Slave is without parameterization  |
| 4    | Ident number High Byte  |
| 5    | Ident number Low Byte  |
The device related diagnostic data provide detailed information on the slave and the peripheral modules. The length of the device related diagnostic data is fixed at 10Byte.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit 7...Bit 0</th>
</tr>
</thead>
</table>
| 6    | Bit 0...5: length equipment related diagnostic data  
      | 001010: length 10Byte (fixed)  
      | Bit 6...7: Code for equipment related diagnostics  
      | 00: Code 00 (fixed) |
| 7    | Bit 0...Bit 7: equipment related diagnostic message  
      | 12h: Error: data length parameters  
      | 13h: Error: data length configuration data  
      | 14h: Error: configuration entry  
      | 15h: Error: VPC3 buffer calculation  
      | 16h: Error: missing configuration data  
      | 17h: Error: Difference DP parameterization and configuration  
      | 40h: User defined diagnostic is valid |
| 8...10 | reserved |
| **11...15** | User specific diagnostic data that are stored behind the diagnostic status byte in the process picture of the CPU. This data may be overwritten and forwarded to the master. |

In case of a diagnostic action the contents of Byte 11...15 of the equipment related diagnostic data will be transferred to the process image of the CPU and get a status byte in front.

Where this diagnostic block with a length of 6Byte is located in the process image is definable via the CPU parameters.

You start diagnostics by means of a status change from 0 → 1 in the diagnostic status byte. This transmits the respective diagnostic message to the master. **A status of 0000 0011 is ignored!**

The diagnostic block of the CPU has the following structure:

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit 7...Bit 0</th>
</tr>
</thead>
</table>
| 0    | diagnostic status byte:  
      | Bit 0: user specific diagnostic data  
      | 0: invalid diagnostic data  
      | 1: valid diagnostic data (starting a diagnosis)  
      | Bit 1: delete diagnostic  
      | 0: diagnostic deletion invalid  
      | 1: diagnostic deletion valid  
      | Bit 2...Bit 7: reserved |
| **1...5** | Bit 0...Bit 7: user specific diagnostic data equal to Byte 11...15 of equipment related diagnostic |
Internal status messages to CPU

The current status of the PROFIBUS communication procedure is obtainable from the status messages that are mapped into the peripheral addressing range of the CPU. Status messages consist of 2Byte with the following structure:

<table>
<thead>
<tr>
<th>Status Byte 0</th>
<th>7</th>
<th>0 Bit-No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: Communication processor in normal operation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: Receive data cleared</td>
<td></td>
<td></td>
</tr>
<tr>
<td>reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Parameter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: no valid parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: parameter data found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Response control (active)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: Response control not active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: Response control activated by DP master</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status PROFIBUS data transfer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: Data transfer error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: Data transfer via PROFIBUS active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>reserved</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status Byte 1</th>
<th>7</th>
<th>0 Bit-No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameterization</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: valid parameterization</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: invalid parameter telegram from DP master</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: valid configuration data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: no congruence with DB1 parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Response control (Watchdog)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: Response control is still running</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: PROFIBUS response control has been executed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hardware control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: PROFIBUS controller VPC3plus is ok</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: PROFIBUS controller VPC3plus is defect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0: PROFIBUS slave waits for parameters from master</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: PROFIBUS slave is in state PROFIBUS data exchange</td>
<td></td>
<td></td>
</tr>
<tr>
<td>reserved</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 4 PROFIBUS communication

**Parameter**

**Clear Data**
The transmit and receive buffers are cleared when an error occurs.

**reserved**
These bits are reserved for future use.

**User Parameter**
Indicates validity of the parameter data. Parameter data is entered into the master configuration tool.

**Response monitoring (active)**
Indicates the status of the activation of the response monitor in the leading PROFIBUS master. The slave will terminate communications when the response monitoring time is exceeded.

**PROFIBUS data exchange status**
Status indicator for master communications. A bad configuration or bad parameters will terminate communications and the respective error is indicated by means of this bit.

**Parameter configuration**
Displays the status of the configuration data. The length of the configuration data and the number of parameter bytes is analyzed. The configuration is only accepted as being correct if these are equal and if no more than 31Byte of parameter data is transferred.

**Configuration**
Status indicator of the configuration data that are received from the PROFIBUS master. You define the configuration by means of the master configuration tool.

**Response monitoring (Watchdog)**
Indicates the status of the response monitor in the PROFIBUS master. This location contains an error when the response monitor has been activated and the required response time has been exceeded in the slave.

**Hardware monitoring**
This bit is set if the PROFIBUS controller in the CPU 21xDP is defective. In this case you should contact the VIPA Hotline.

**DP data**
Any transfer error on the PROFIBUS will set this error.
PROFIBUS installation guidelines

PROFIBUS in general

- A PROFIBUS DP network may only be built up in linear structure.
- PROFIBUS DP consists of minimum one segment with at least one master and one slave.
- A master has always been deployed together with a CPU.
- PROFIBUS supports max. 126 participants.
- Per segment a max. of 32 participants is permitted.
- The max. segment length depends on the baud rate:
  - 9.6 ... 187.5kbaud → 1000m
  - 500kbaud → 400m
  - 1.5Mbaud → 200m
  - 3 ... 12Mbaud → 100m
- Max. 10 segments may be built up. The segments are connected via repeaters. Every repeater counts for one participant.
- The bus respectively a segment is to be terminated at both ends.
- All participants are communicating with the same baud rate. The slaves adjust themselves automatically on the baud rate.

Transfer medium

As transfer medium PROFIBUS uses an isolated twisted-pair cable based upon the RS485 interface.

The RS485 interface is working with voltage differences. Though it is less irritable from influences than a voltage or a current interface. You are able to configure the network as well linear as in a tree structure.

Max. 32 participants per segment are permitted. Within a segment the members are linear connected. The segments are connected via repeaters. The maximum segment length depends on the transfer rate.

PROFIBUS DP uses a transfer rate between 9.6kbaud and 12Mbaud, the slaves are following automatically. All participants are communicating with the same transfer rate.

The bus structure under RS485 allows an easy connection res. disconnection of stations as well as starting the system step by step. Later expansions don’t have any influence on stations that are already integrated. The system realizes automatically if one partner had a fail down or is new in the network.
Bus connection

The following picture illustrates the terminating resistors of the respective start and end station.

![Diagram of PROFIBUS communication](image)

**Note!**
The PROFIBUS line has to be terminated with its ripple resistor. Please make sure to terminate the last participants on the bus at both ends by activating the terminating resistor.

**EasyConn bus connector**

In PROFIBUS all participants are wired parallel. For that purpose, the bus cable must be feed-through.

Via the order number VIPA 972-0DP10 you may order the bus connector "EasyConn". This is a bus connector with switchable terminating resistor and integrated bus diagnostic.

![EasyConn connector](image)

<table>
<thead>
<tr>
<th>Angle</th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>0°</td>
<td>64</td>
<td>34</td>
<td>15.8</td>
</tr>
<tr>
<td>45°</td>
<td>61</td>
<td>53</td>
<td>15.8</td>
</tr>
<tr>
<td>90°</td>
<td>66</td>
<td>40</td>
<td>15.8</td>
</tr>
</tbody>
</table>

in mm
Note!
To connect this EasyConn plug, please use the standard PROFIBUS cable type A (EN50170). Starting with release 5 you also can use highly flexible bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322.
With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool that makes the connection of the EasyConn much easier.

Termination with "EasyConn"
The "EasyConn" bus connector is provided with a switch that is used to activate a terminating resistor.

Attention!
The terminating resistor is only effective, if the connector is installed at a bus participant and the bus participant is connected to a power supply.

Note!
A complete description of installation and deployment of the terminating resistors is delivered with the connector.

Wiring
1./last bus participant

1. loose the screw.
2. lift contact-cover.
3. insert both wires into the ducts provided (watch for the correct line color as below!)
4. please take care not to cause a short circuit between screen and data lines.
5. close the contact cover.
6. tighten screw (max. tightening torque 4Nm).

Please note: The green line must be connected to A, the red line to B!
Example

**Objective**

This example is intended to show the communication between a master CPU 214DPM and a slave CPU 214DP. The counters are to communicate via the PROFIBUS and to be displayed at the output module of the respective partner.

**Detailed description of the objective**

The CPU 214DPM shall count from FFh...00h and transfer the count cyclically into the output area of the PROFIBUS master. The master has then to transfer this value to the slave of the CPU 214DP.

The value received shall be saved in the peripheral input area of the CPU and monitored at the output module (at address 0) via the backplane bus.

On the other hand, the CPU 214DP should count from 00h to FFh. This count shall also be saved in the output area of the CPU slave and be transferred to the master via PROFIBUS.

This value shall be monitored at the output module (address 0) of the CPU 214DPM.

Configuration data

**CPU 21xDPM**

Counter: MB 0 (FFh...00h)  
PROFIBUS address: 4  
Input area: Address 10 length: 2 Byte  
Output area: Address 20 length: 2 Byte

**CPU 21xDP**

Counter: MB 0 (00h...FFh)  
PROFIBUS address: 3  
Input area: Address 30 length: 2 Byte  
Output area: Address 40 length: 2 Byte  
Parameter data: Address 50 length: 24 Byte (fixed)  
Diagnostic data: Address 60 length: 6 Byte (fixed)  
Status data: Address 100 length: 2 Byte (fixed)
To be compatible to the Siemens SIMATIC manager, you have to execute the following steps for the System 200V:

- Start the hardware configurator from Siemens.
- Install the GSD-Datei VIPA_21x.gsd.
- Configure a CPU 315-2DP with DP master system (address 4).
- Add a PROFIBUS slave "VIPA_CPU21x" at address 1.
- Include the CPU 214-2BM03 at the 1. slot of the slave system.
- Include the output module 222-1BF00.

For linking-up the CPU 21xDP you have to execute the following steps after including the GSD-file (VIPA04d5.gsd):

- Add the PROFIBUS slave "VIPA_CPU2xxDP" (address 3). The DP slave is in the hardware catalog under: PROFIBUS-DP > Additional field devices > I/O > VIPA_System_200V > VIPA_CPU2xxDP.
- Assign memory areas of the CPU to the in- and output of the PROFIBUS-DP master section in form of Byte blocks. For this, you have to include the "2Byte output" element on the 1. slot and select the output address 20. Include the "2Byte input" element on the next slot and select the input address 10.
- Save your project.
To be compatible to the Siemens SIMATIC manager, you have to execute the following steps for the System 200V:

- Start the hardware configurator from Siemens.
- Configure a CPU 315-2DP with DP master system (address 2).
- Add a PROFIBUS slave “VIPA_CPU21x” at address 1.
- Include the CPU 214-2BP03 at the 1. slot of the slave system.
- Include at the next slot the output module 222-1BF00.

- Choose the following parameters in the parameter window of the CPU 214-2BP03:

  - Save your project.
The application program in the CPU 214DPM has two tasks that are handled by two OBs:

- to test communications by means of the control byte. Load the input byte from PROFIBUS and transfer the value to the output module.

**OB 1 (cyclic call)**

\[
\begin{align*}
L & \quad B\#16\#FF & \text{Control byte for Slave-CPU} \\
T & \quad AB \ 20 & \\
L & \quad B\#16\#FE & \text{Load control value 0xFE} \\
L & \quad EB \ 10 & \text{Was the control byte transferred correctly from the slave CPU?} \\
<>I & \quad & \text{No} -> \text{End} \\
BEB & \quad & \\
\hline
\text{Data exchange via PROFIBUS} & \\
L & \quad EB \ 11 & \text{Load input byte 11 (output data of the CPU214DP) and} \\
T & \quad AB \ 0 & \text{transfer to output byte 0} \\
BE & \\
\end{align*}
\]

- Read counter value from MB 0, decrement, save in MB0 and put it out to CPU 214DP via PROFIBUS.

**OB 35 (timer-OB)**

\[
\begin{align*}
L & \quad MB \ 0 & \text{Counter from 0xFF to 0x00} \\
L & \quad 1 & \\
-I & \quad & \\
T & \quad MB \ 0 & \\
T & \quad AB \ 21 & \text{Transfer into output byte 21 (input data of CPU214DP)} \\
BE & \\
\end{align*}
\]

At this point the programming of the CPU 214DPM is completed. The PROFIBUS communication has also been defined for both sides. Transfer your project into the CPU 214DPM via MPI by means of the PLC-functions.
As shown above, the application program in the CPU has two tasks that are handled by two OBs:

- Load the input byte from the PROFIBUS slave and transfer the value to the output module.

**OB 1 (cyclic call)**

- **L PEW 100** Load status data and save in flag word
- **T MW 100**
- **UN M 100.5** Commissioning by the DP master occurred? No -> End
- **BEB**
- **U M 101.4** Valid receive data? No -> End
- **BEB**
- **L B#16#FF** Load control value and compare to control byte
- **<>I** (1. input byte)
- **BEB** Received data does not contain valid values
- **L B#16#FE** Control byte for master-CPU
- **T PAB 40** Data exchange via PROFIBUS

- **OB 35 (timer-OB)**

- **L MB 0** Counter from 0x00 to 0xFF
- **L 1**
- **+I**
- **T MB 0**
- **T PAB 41** Transfer counter value into peripheral byte 41 (output data of the PROFIBUS slave)

- Read counter value from MB 0, increment, save into MB0 and put it out to CPU 21x via PROFIBUS.